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IMPORTANT INFORMATION !

This publication is an illustrated version of FAAD online help . Since the user can
access and print online help directly from the application, online help is considered
the primary source for information about FAAD.

When you print online help directly from the application, the format is different from
this illustrated version; however, the text is the same. Therefore, NFC provides the
illustrated version only upon customer request.

For information about this publication, please contact the Directives and Analysis
Branch (DAB). Instructions for contacting DAB and other support sources are
provided in the About This Procedure section of this publication.

Published and printed by the Directives and Analysis Branch
National Finance Center, U.S. Department of Agriculture
New Orleans, Lousiana
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User Survey
For

USDA/NFC Procedures

The Directives and Analysis Branch requests your Return the survey within 30 days to:

comments on this procedure. To help us evaluate and r
improve the effectiveness of our publications, please
answer the questions below.

Directives and Analysis Branch

USDA/NFC
P.O. Box 60000

New Orleans, LA 70160-0001

L 4
Optional:
Federal Assistance Award Data User Name Phone No.
(FAAD) System
Procedure Name Job Title Grade
\A 2 / /
Title Chapter Section Subsection Address
City State ZIP
1. How helpful is the procedure to you in 5. How frequently do you use the
performing your job? procedure?
[J  Very helpful 0 Daily
O Fairly helpful 0 Weekly
[0 Not very helpful because
[0 Monthly
O Other:
2. Is the format easy to follow?
[ Yes 6. Have you found any errors in the
O No, | suggest procedure?
0 No
O Yes
3. Is the writing easy to understand?
O Yes
U No, I'suggest 7. What recommendations/comments

would you like to make regarding this
procedure?

4. Are the instructions/exhibits clear and

easy to follow?

[l Yes

O No, I suggest

THANK YOU FOR COMPLETING THIS SURVEY!



Title V, Chapter 2
Federal Assistance Award Data (FAAD) System



Title V, Chapter 2
Federal Assistance Award Data (FAAD) System

Latest Update Information

FAAD 02-1, Release of FAAD Version 02.01, dated March 15, 2002, announced the release of
Version 02.01 of the FAAD software, and an expanded Error Codes/Messages listing.

Listed below is a summary of the changes to the FAAD procedure:

Description of Change

Page(s)
Added Enhanced Figure 46, Individual Suspense Record window 66
Expanded Error Codes/Messages listing 119-120

Changes in the text are identified tk/ <

Updated 3/15/02 Latest Update Information [
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About This Procedure

This procedure provides instructions for accessing and operating the Federal Assistance Award
Data (FAAD) System. The following information will help you use the procedure more
effectively and locate further assistance if needed.

How The Procedure Is Organized

The major sections of this procedure are described below:

Introduction presents an overview of FAAD, including security access information and
instructions for accessing the system. It also provides basic operational information
including how to get help using FAAD.

Getting Started provides basic information on the system features available in FAAD.

Using FAAD provides information and instructions on using the specific windows in FAAD
to process data.

Field Instructions contain instructions for or descriptions of the fields on FAAD windows.

Reference Tables include tables of valid values for completing the fields on FAAD
windows.

The Exhibit contains a listing of the FAAD FOCUS data elements.
Glossary defines terms used throughout the procedure manual.

Heading Index provides an alphabetical list of all headings in the procedure. When a
heading is referenced, you can use this index to locate the page number.

To keep you informed about new or changed information related to this system, NFC issues short
publications called bulletins or amendments. This procedure and all related bulletins and
amendments are listed in the NFC External Publications Index, issued semiannually.

If you receive this procedure after it has been amended, you will receive the publications with all
amendments and bulletins. Remove and insert amended pages according to the accompanying
page control chart so that your procedure is current.

vi How The Procedure Is Organized Updated 3/15/02
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What Conventions Are Used

This procedure uses the following visual aids to identify certain kinds of information:

Convention

Example

Messages displayed by the system
are printed in italics.

The messag#nput Must Match This
Pattern-$$$,$$%,$%9 is displayed.

Important extra information is
identified by a note, warning, caution,
or reminder icon in the left margin.

=

Note

If the transaction is coddd(incomplete), no
edits are performed.

Figure references link figures with the
text. These references are printed in
bold sans serif font.

The Agreement List windoWFigure 11) is
displayed.

References to headings in the
procedure are printed in the same font
as figure references.

Note: When a heading is referenced
in the procedure, you can use the
Heading Index to locate the page
number.

To obtain information on help text and
windows display, seEAAD Menu Bar .

References to menu options are
printed in bold italics .

To view a FAAD report by state select:
Reports > State .

References to command buttons or
keyboard keys are printed in bold and
enclosed in brackets.

To return to the previous window, click
[Close] .

At any time during the entry process, you can
get help with completing a field by pressing
[F1].

Field names are printed in the margin.
Field specifications are printed in
italics.

Note: Field entries are identified as
required?, conditional? optional’,
optional default4, or no entry?®.

CFDA Number

Required, alphanumeric, 5 positions

Type a valid number from the Catalog of
Federal Domestic Assistance. The first box ¢
the field is a 2-digit prefix and represents the
Federal department. Tyd® for the prefix. The
second box of the field is a 3-position
alphanumeric suffix and represents the
program. Type the suffix.

=

1Required

2Conditional
3Optional
40optional defaslt.

5No entry

Who To Contact For Help

Updated 3/15/02

For questions about the system (including help with unusual conditions), contact Customer
Support personnel &04-255-5230.

You must enter data in the field. (Note: All mandatory fields on FAAD windows are highlighted to distinguish
required entries from optional entries. The highlighted fields must be completed to avoid rejection.)

You may be required to enter data, based on criteria indicated in the field instructions.

You may elect to enter data in the field. If the field is left blank, no data is system generated.
You may elect to enter data. If the field is left blank, the system generates a default entry.
You do not enter data in the field. The field instruction states the reason for no entry.

For FAAD technical processing questions, contact OCFO persorn2@?-at20-1553.

For questions about reporting requirements and suspense processing, contact the Accounting

Systems Control Section 894-255-5446.

For access to FAAD, contact your agency’s ADP security officer.

For questions about this procedure, contact the Directives and Analysis Bra0dh2&5-5322

What Conventions Are Used vii
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Introduction

This section presents the following topics:

=1
=
=
o
o
c
o
=3
o
S

About FAAD
NFEC/Organization Responsibilities

Access, Security, And Installation

About FAAD

FAAD is a Windows-based application that was developed and is maintained by the National
Finance Center (NFC). FAAD operates in a windows environment requiring Windows 95 or
higher. This application is used to:

* Provide a central source of information on Government domestic financial assistance
programs.

* Maintain detailed information on the type of assistance program, recipient name, and
type of project funded.

* Provide consistent, standardized program information.

» Collect consolidated Department program data for quarterly reporting to the Bureau of
Census.

» Collect information on programs located abroad that are funded by domestic grants.

FAAD allows users to add, modify, query, and delete records; correct suspense records; and
generate reports on current/historical FAAD data. In addition to accessing the Windows
version of FAAD, some users have opted to submit their data via tape or remote job entry.
For detailed information on this alternative method of processing your assistance data, see
The Batch Process Environment

Through FAAD, client agencies are to report activity for each quarter in the fiscal year.
Reporting should be in accordance with the guidelines stipulated in this procedure unless
specific waivers have been granted by the Office of the Chief Financial Officer (OCFO) or

the Bureau of Census.

For more information, see:
Regulations Affecting FAAD
FAAD Exception Reporting
Reporting To The Bureau of Census

Regulations Affecting FAAD

Updated 3/15/02

The Federal Government provides billions of dollars annually for domestic financial
assistance programs to state and local governments, nonprofit organizations, private
hospitals, colleges, small businesses, and individuals. The funds are made available in the
form of grants, loans, veteran and retiree benefits, and numerous other types of assistance

payments.

About FAAD 1
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FAAD is regulated by Title 31, section 6102(a) of the United States Code. Through effective
use of FAAD, Federal agencies are aided in their capabilities to comply with section 201 of
the Intergovernmental Cooperation Act of 1968 (Public Law 90-577). FAAD also provides
data consistent with the requirements and intent of the following other regulations:

* Executive Order 12372 dated July 1982
* Federal Grant and Cooperative Agreement Act of 1977 (Public Law 95-224)
* Federal Program Information Act

» Legislative Reorganization Act of 1970 (Public Law 91-510), as amended by the
Congressional Budget Act of 1974 (Public Law 93-344)

FAAD Exception Reporting

Normally, OCFO will not issue a total exemption to an agency on the timeframes for
reporting its assistance data. However, OCFO can issue a waiver using the following
guidelines:

1. An agency should request a waiver when it is determined that they cannot meet the
specified reporting timeframes.

2. An agency'’s request for a waiveust be in writing and received by Census,
Government Division, no later th&eptember 1

3. An agency’s waiver request should be signed by the appropriate agency policy official
and be accompanied by a detailed compliance plan identifying the specific
problems/deviations, actions, costs, and timeshare required to achieve full compliance
with the reporting requirements.

Reporting To The Bureau of Census

Using internally-produced reports, NFC operational personnel contact client agency
offices as a reminder to ensure that their FAAD data has been submitted to NFC for

processing.
= This contact is performed approximately on the 15th of the quarter month that
Note reporting is due to Census.

NFC/Organization Responsibilities

Listed below are the responsibilities of the primary organizations involved in FAAD
processing and application maintenance.
The Office of the Chief Financial Officer (OCFO):

» Provides oversight responsibility for functions relating to FAAD policy as well as final
decisions concerning FAAD operation, comprehensiveness, and applicability.

» Encourages public discussions through solicitation of advice of representatives from
state and local governments, interest groups, Congress, Federal agencies, and the
general public on FAAD policy and future developments.

2 NFC/Organization Responsibilities Updated 3/15/02
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e Collaborates with the Bureau of Census on the review of recommendations and i
identified by focus groups.

=1
=
=
o
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The National Finance Center (NFC):
* Maintains a master file of FAAD data.

* Receives and processes all agency-submitted FAAD data.

* Produces reports for Departmental and agency use to facilitate in the control and
administration of all Federal financial assistance programs.

The Agency:
* Administers the financial assistance programs granted to the agency.

» Ensures the quality and accuracy of award data entered into FAAD.

* Collects, reviews, and enters assistance award data into FAAD.

The U.S. Department of Commerce, Bureau of Census:

» Serves as the FAAD executive agent as designated by OCFO by providing daily
system operational support.

* Provides computer support, data processing, and maintains liaison with the reporting
Federal agencies, states, and other data users.

» Performs follow-up action whenever errors are detected in agency data.

Ad hoc Federal Interagency Focus Groups:

» Convene as necessary to evaluate processes and formulate recommendations to resolve
specific problems, and analyze alternative methods for the reporting of data

Access, Security, And Installation

Security is designed to prevent unauthorized use of systems and databases. For security
information, including user identification numbers (user ID’s), passwords, and obtaining
access to a specific system, see the Security Access procedure (Title VI, Chapter 1,
Section 1).

For more information see:
Requesting Access To FAAD

Database Security

Installation

Requesting Access To FAAD
To access FAAD:

* Use a personal computer and a secured telecommunications link to NFC.

Updated 3/15/02 Access, Security, And Installation 3
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* Have authorized security clearance.

» Ensure that the following hardware and software requirements are in place:
» PC capable of supporting Windows 95 or higher or Windows NT 4.0
* Approximately 20 MB of available disk space
* Super Video Graphic Array (SVGA) monitor set to 800X600 resolution
* Transmission Control Protocol/Internet protocol (TCP/IP) stack
» Secure TCP/IP connectivity to NFC

* NFC Logon software

» FAAD System application software

For information about connecting and disconnecting from your telecommunications network,
see the instructions that are provided with your specific network.

Individuals must request access through their agency’s security officer. The request should
provide the following information:

* User name

* User SSN

* UserlID

* Agency name

* User access request level
» Telephone number

* Application name (FAAD)

The access level requested should be based on the individual’s assigned work requirements
and job functions.

Database Security

The following information describes the security environment at NFC:

Security Software. System security at NFC is managed by CA TOP SECRET, a commercial
access control package operated in an Operating System (OS) 390 environment. CA TOP
SECRET provides protection for dataset, library programs, input/output devices, and most
system resources. It also controls access to data processing resources and facilities through a
three-step process as follows:

1. CA TOP SECRET validates the user to determine if the user is authorized to use
FAAD. The user’s logon access (user ID and password) is validated during the logon
process.

2. CA TOP SECRET confirms that the user is authorized to use the requested facility.

3. CA TOP SECRET determines if the user is authorized to use the requested resources
(i.e., datasets, programs, transactions, database subschemas, DB2 resources, Security
Access Code (SAC), etc.).

4 Access, Security, And Installation Updated 3/15/02
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Validation Process.To facilitate access to NFC-maintained systems, significant
interaction/interface among software packages is necessary to control access. The folld
steps occur during a logon to FAAD.

ucionpoau|

1. The individual is prompted to enter ID and password.
2. At the Application icon, the individual selects FAAD.
3. CA TOP SECRET validates the ID, password, and access authorization to FAAD.

4. Upon verification/validation of the ID and password, the individual is logged on to the
NFC mainframe computer and into FAAD.

5. CA TOP SECRET is checked again to determine if the individual can access the DB2
resources controlled by TOP SECRET. CICS (Customer Information Control System)
transactions are also checked. If the TOP SECRET permissions exist, then access is
allowed.

6. The SAC is used to verify if access is to be granted to a particular record. The SAC
entry path is:

SAC: FADDSSAA Where DD=Department, SS=Servicing agency, AA=Agency
serviced

The SAC entry in the individual’'s TOP SECRET profiles is read to determine if the access
should be allowed.

Installation

Instructions for installing FAAD are provided with the software. Be sure to read the hardware
and software requirements to ensure that you have the proper equipment and adequate disk
space for successful installation.

Updated 3/15/02 Access, Security, And Installation 5
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Getting Started

This section presents the following topics:
Learning About FAAD

Starting FAAD
Changing Your Password

FAAD Banner Window

Exiting FAAD
Using Online Help

FAAD Operating Features

Learning About FAAD

To use FAAD, you must have knowledge of Microsoft Windows. Use your Windows use€
guide for navigating in a Windows environment. Use this procedure for help with FAAD

pauels bumes

processing.

For more information, see:

The Online Tutorial

Online Help

The Online Tutorial

An online tutorial will be developed for FAAD to help you become familiar with the
application. It will include an overview of the FAAD functions and how to navigate through
FAAD using tool buttons, command buttons, special function keys, and directional keys.

The tutorial will also describe how to:

Enter an individual or aggregate agreement.
Modify/update agreement data

Establish a CFDA number record.

Enter a recipient name.

List all of the functions of the FAAD application.

You will be able to run the tutorial directly from CD-ROM, or you can install it to individual
PC’s or a shared LAN drive. Both installation methods create icons on the Start Programs
menu under a specified folder.

Online Help

The online help feature is available to guide you as you process data in FAAD. To get help,
selectHelp from the menu bar at any window. A drop-down menu is displayed with the
following options:

Updated 3/15/02

Learning About FAAD 7
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Help For This Window. Provides instructions for the current window.
Help Contents.Provides the online documentation for FAAD.

Help for Help. Provides instructions for using the online help.

For online help, selectelp > [help option]at a menu bar. For help with a specific field, click
the field in question and pref].

Starting FAAD

You must first activate the NFC Welcome banner before you can access FAAD as described
below.

To start FAAD:

1.
2.
3.
Note
8 Starting FAAD

At your Windows desktop, selestart > Programs > National Finance Center > NFC
Logon . The NFC Welcome banner windowidure 1) is displayed.
= '01 onal Finance Center

File  Window Help

—Logon

USDA National I E—

/—‘,_.————" F i nance Password li
F  lcenter —
Ew ORLEGA®NG® . LOUILSIA->NA o ity K

For Authorized Use Only

—#Applications

x LCancel

I E

Ius_n?.nss |12:5?:03

Figure 1. NFC Welcome Banner window

Complete the fields in the Logon area as indicated udgenelcome Banner
Window Field Instructions

After completing the fields, clickogon] . A list of the applications you are authorized
to access is displayed and the messageHave Successfully Logged Into NFC is
displayed on the message line.

The Password Check pop-upgure 2) appears when your password is near
expiration.

Updated 3/15/02
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1 Pazsword Check

\E) “Your pazswaord will expire in 5 day(z).

Figure 2. Password Check pop-up

Q)
(0]
=3
=]
«
9]
—
QO
3
(9]
o

Click [OK] to close the pop-up. As needed, change your password using the
instructions unde€hanging Your Password .

4. Select(FAAD) Federal Assistance Award Data System v01.02  and click[Start] . The
FAAD banner is displayed. For more information, BRRD Banner Window .

= If the current version is not installed, a message appears indicating that access is
Note denied and the current version must be installed. You cannot access the application nor
can you use the prior version.

Changing Your Password

You may change your password at any time but not more than once a day.

To change your password:

1. Atthe NFC Welcome banner, sel&it > Change Password . The Change Password
window (Figure 3) is displayed.

Change Paszzword

User Id | |

Old Password |

Hew Password |

Confirm Hew Password |

x Cancel

Figure 3. Change Password window

Updated 3/15/02 Changing Your Password 9



Title V, Chapter 2
Federal Assistance Award Data (FAAD) System

2. Complete the fields as indicated und@ange Password Window Field Instructions

3. After completing the fields, clicfOK] to save the change and exit the window.

FAAD Banner Window

After you start FAAD, the FAAD banner windowigure 4 ) appears.

EIETS 21 [ETRCE Al F
Fr Rariras  Yewe Bepes e Fel

“

Wormien iH 83

USD National

e Finance

_ Center

Ted Rarmadingd Liea Grdy

T HES 11N

Figure 4. Federal Assistance Awards Data (FAAD) System Banner window

The menu bar on the FAAD banner window displays the following options and drop-down

menus:
Menu Bar Drop-down Menu
Option Options Description Notes
File Exit Used to exit FAAD.
Maintenance Agreement Used to display the Agreement
List window.
Suspense Used to display the List Suspense
Transmission window.
CFDA Used to display the List CFDA
window.
Recipient Name Used to display/search for a
specific recipient name.
Used to display the Recipient
Name window.
View Dept/Agency Used to display the List

Department and Agency window.

Geographical Used to display the List State/
County/City/Zip/Congressional
District window.

10 FAAD Banner Window Updated 3/15/02
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Menu Bar Drop-down Menu
Option Options Description Notes
Reports State Used to display the State Report
window to select report criteria.
Agency Used to display the Agency
Report window to select report
criteria.
Recipient Used to display the Recipient
Report window to select report
criteria.
Window Cascade Used to change the way your This is a Microsoft
windows are positioned on your Windows feature. For Q
monitor. more information, see g
your Windows user’s Q
guide or select Help > 9
Help For Help at the 5
FAAD menu bar. 3
Tile The Tile option does not
appear on the banner
menu bar.
Help Help For This Used to get help for the current This is a Microsoft
Window window. Windows feature. For
more information, see
your Windows user’s
guide or select Help >
Help Contents Used to see the Table Of Contents Help For Help at the
for FAAD online help. FAAD menu bar.

For pop-ups,

window-level help is

available only if a Helb
Help For Help Used to get help for the Microsoft  button is on the pop-up.

Windows help system. For more information,
see Using Online
Help.

For more about the menu bar, S&e FAAD Menu Bar .

Exiting FAAD

To exit FAAD:

1. At any FAAD menu bar, clickClose] until you are returned to the FAAD banner
window.

2. At the FAAD banner window, sele€tle > Exit to exit FAAD and return to the NFC
Welcome banner.

= To disconnect from the NFC mainframe, clitkgoff] at the NFC Welcome banner window.

Note

Using Online Help

FAAD provides complete online documentation designed in a Microsoft Windows online
help system. If you are not familiar with using Microsoft help systems, see a Windows user’s

Updated 3/15/02 Exiting FAAD 11
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guide or selectelp > Help For Help at the FAAD menu bar. When you need help with

processing FAAD data, clickelp at any FAAD menu bar. A drop-down menu is displayed
with the following options:

Option Description

Help For This Window Provides instructions for the current window. For pop-up windows,
help is available only if a Help button is on the pop-up.

Help Contents Provides complete online documentation for FAAD.

Help For Help Provides instructions for using the Microsoft Windows help
system.

= When you seledtfelp Contents , the FAAD Help windowKigure 5) appears with
e information about how to use FAAD Help.

& FRAD Hilg
[ie Lot Hxkpet [pboe Hep
otarss | [rdss | frel | Hep o] Pt | Dpwors | | |
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M=) ko 5 bwweerzid i1 6w
Fird] 21 e =ord sssch esture

¥ Ior ek vl balg, 0k k| T] a7 e = nodoss mereg B B iredawr b Felp o read il sbla o
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§  F i Tl e g, 8 D0 miai Cur | B Pl B i E paadE [F1R
& For ey evoerialon B0 ik o b PRl il B i I 6 e O e
DR Mg Makolifcid

For i rite quessiion 5 she gl e st d ncisd ng B eip with g gea cond i pres), caniat imlormradion Cenier
perecavrel o Sl 300 52 M

Fior 1B OA Rkl DO i3 BLrTon 5, Dol DGO porsona el ol 2IE-T20- 553

Fior i sl e S0 repd i (o Erienls o B e S i & proirs e, ©oonle ] e A bl il g Sk
GO SR BT T - 55 SA

For quaslorm sbeesd FARD @i, confec] your agerey 8 ADOF o sc wrily ofioer FRAD Hslg gives you rsaci
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Figure 5. FAAD Help window

At the help window menu bar, cligkontents] . The Help Topics table of contents is
displayed.

This window provides three ways to locate information:

Options Description

Contents Displays the table of contents for online documentation.
Index Provides an index of key words.

Find Provides word search capability.

For instructions on using these Microsoft help features, sttt Help For Help at the
menu bar on any FAAD window.
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FAAD Operating Features

FAAD is designed in a windows format, providing mouse-driven, point-and-click
functionality; menu bars; drop-down menus; tool buttons; and other windows features. The
system’s windows are designed in a hierarchical approachmvsticlose all previously

opened windows before you can exit the system. This section reviews these basic windows
features and describes others that are specific to the FAAD application.

== Be sure to readbout This Procedure _ to learn what visual aids are used throughout the
Nee  documentation.

For more information, see:
The FAAD Menu Bar
The FAAD Toolbar
EAAD Pop-Up Windows
FAAD Functional/Directional Keys

Saving Data

Deleting Data
Scrolling Records

pauels bumes

Using The Typographical Error Pop-up
System Edits

The FAAD Menu Bar

The menu bar appears below the title bar on all FAAD windows except pop-ups. Each option
on the menu bar displays options for viewing and/or processing transactions. When an option
from the menu bar is selectedd@p-down menu appears, showing a list of options.

= Options shown in gray are not available for use and do not respond to selection.

Note

The FAAD Toolbar

The tool bar is a row of tool (icon) buttons located below the menu bar. Each tool button

displays an icon that depicts its processing function. In most cases, the tool button can be
used in lieu of the menu bar.

Tool buttons used throughout FAAD are shown in the following table. Those that are unique
to a particular function are discussed under the topics where they apply.

= Even though there are multiple ways in which to complete an action at a given window in
Nete  EAAD, the approach used in developing this procedure concentrates on using the menu bar
options rather than the tool buttons.

Updated 3/15/02 FAAD Operating Features 13
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FAAD Tool Buttons

Button Description
Used to display search windows that display various types of search
) criteria for locating data.

Used to print a window.

=i
@ Used to display the Recipient Additional Description window.
o Used to save and edit entered data.

Used to scroll backward to the previous record.

Used to scroll forward to the next record.

Used to display help text.

?

'ﬁ Used to exit a window.
e Used to add a new item.
[nuns]
.

..... Used to update an item.
o)

iy

----- Used to delete an item.
Used to display the Recipient Location Description window.
_____ Used to select and return.

Used to display geographical information.

Used to display batch transmission records.

o)
El
o=~ —a Used to display the error message(s) for batch transmission records.
E
% Used to display the Recipient Alias window.
; Used to display the Forest Service Project Details pop-up.
i

Used to display the Display Individual Agreement window or the
Display Aggregate Agreement window.

Used to display the Individual Agreement History detail window or the
Aggregate Agreement History detail window.

14 FAAD Operating Features Updated 3/15/02
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Used to display the Agreement History List window.

g

Agg Used to display the Aggregate Suspense Record window.
Tnd Used to display the Individual Suspense Record window.
1

FAAD Pop-Up Windows

Pop-up windows do not have a menu bar or a tool bar; however, they do have commal
buttons that carry out an action implied in the button’s name. FAAD pop-ups include the
following command buttons used throughout FAAD:

Q)
(0]
=3
=]
«
9]
—
QO
3
(9]
o

FAAD Command Buttons

Button Description
Used to close the pop-up save the data, read the data, delete
OK the selected record, or update a change.
Used to close the pop-up/window and not save the data.
Cancel
Used to close the pop-up.
Close
Used to perform a search command.
Find
Used to answer yes to save changes.
Yes
Used to answer no to save changes.
No
Used to display window-level help. Some pop-up’s do not
? Help have window-level help.
Used to save entered data.
Save

FAAD Functional/Directional Keys

Your keyboard includes the following function keys that can be used in FAAD:

Function Keys

A
D
<

Description
Used to accept/process data.

Enter

Used to delete data.
Delete

o Used to move to the next field.

Updated 3/15/02 FAAD Operating Features 15
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Function Keys

Key Description

Used to create a space or tab to the next field.

Used to move to the next character within a field.

Used to move the previous character within a field.

Used to display help.

Used to close a window.

Used to scroll backward.

Used to scroll forward.

T
©

[%2]
o

Saving Data

FAAD includes a Save Changes pop-Bjgyre 6 ) which facilitates saving data prior to
exiting the window. The Save Changes pop-up is displayed when youRleleatiose
prior to saving your data.

FA2005 Save Changes

Changes have been made. Save changes?
Yes Ho | Cancel |

Figure 6. Save Changes pop-up (Sample Pop-up from the FA2001-Add CFDA window)

To respond to the save changes pop-up:

* Click [ves] to save the entries and edit the action. If the data passes all edits, the saved
data is updated to the FAAD database.

» Click [No] to exit the window and not save the entries.

» Click [Cancel] to return to the previous window where the entries were being made.

A save changes pop-up can be displayed from several FAAD windows that allow add and
update actions. Regardless of which add/update window is accessed, the pop-up is virtually
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Deleting Data

the same. The save changes pop-up number varies based on the type of add/update action you
make. In addition to the varying pop-up numbers, the pop-up titles and wording may deviate
from one pop-up to another. Therefore, since saving changes is accomplished in the same

manner from pop-up to pop-up, a sample save changes pop-up is shown only once in the
procedures.

FAAD includes a confirm delete pop-ufidure 7 ) which facilitates deleting a selected
record from the database. The confirm delete pop-up is displayed when yousebect
Delete. The confirm delete pop-up allows you to perform a verification of the delete prio
actual deletion of the record from the FAAD database.

FA9002 Confirm Becipient Hame Delete

Please confirm that you wish to delete selected Recipient Hame.

Q)
(0]
=3
=]
«
9]
—
QO
3
(9]
o

Cancel ‘

Figure 7. Confirm Recipient Name Delete pop-up  (Sample From FA9001-Recipient
Name window)

To respond to the confirm delete pop-up:

» Click [OK] to delete the record. The record is deleted from the FAAD database.
Depending on the type of record deleted, the data may be retained in the system for
history purposes.

* Click [Cancel] to close the confirm delete pop-up arat delete the record. The
system returns to the previous window with the selected record highlighted.

A confirm delete pop-up can be displayed from several FAAD windows that allow delete
actions. Regardless of which type of record is being deleted, the pop-up is virtually the same.
The confirm delete pop-up number varies based on the type of record being deleted. In
addition to the varying pop-up numbers, the pop-up titles and wording may deviate from one
pop-up to another. Therefore, since deleting a record is accomplished in the same manner

from pop-up to pop-up, a sample confirm delete pop-up is shown only once in the
procedures.

Scrolling Records

Updated 3/15/02

FAAD includes a confirm scroll pop-ufigure 8). The confirm scroll pop-up is displayed
when a row of data is highlighted and you attempt to scroll. This confirm scroll pop-up
serves as a prompt to alert you that if you continue to scroll beyond the record limit, the
system will not maintain the highlight on the selected record.

FAAD Operating Features 17
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FABD03 Confirm Scroll

Retrieval of new data will occur, selected rows will be unhighlighted.
OK Cancel

Figure 8. Confirm Scroll pop-up  (Sample from the FA5001-List
State/County/City/Zip/Congressional District window)

To respond to the confirm scroll pop-up:

» Click [OK] to deselect the highlighted data and continue the scroll. The system then
displays the next logical set of rows of records on the database.

» Click [Cancel] to close the confirm scroll pop-up and retain the same page of records
with the selected record highlighted.

A confirm scroll pop-up can be displayed from several FAAD windows that display rows or
pages of data. Regardless of which type of record is displayed, the pop-up is virtually the
same. The confirm scroll pop-up number varies based on the type of record being displayed.
In addition to the varying pop-up numbers, the pop-up titles and wording may deviate from
one pop-up to another. Therefore, since scrolling records is accomplished in the same manner
from pop-up to pop-up, a sample confirm scroll pop-up is shown only once in the

procedures.

Using The Typographical Error Pop-up

FAAD includes a typographical error pop-wig@ire 9 ). The typographical error pop-up is
displayed only after you selegte > Save or click 1 for an update to an individual or

aggregate agreement record thatdde=ady been reported to Census

FAFD0D4 Typographical Error

Wias the update due to a typographical error?

_* |

Figure 9. Typographical Error pop-up  (Sample from the FAF001-Update Individual
Agreement window)

To respond to the typographical error pop-up:

» Click [Yes] to indicate that the modification being made was due to a typographical
error. The system updates the database and returns you to the Agreement List window
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System Edits

Updated 3/15/02

displaying the agreement with the modified data. Addition&ipo Erroris carried
in the upper right portion of the Individual Agreement History and Aggregate
Agreement History windows.

» Click [No] to indicate that the modification wast a typographical error correction.
The system updates the database and returns you to the Agreement List window
displaying the agreement with the modified data.

As mentioned above, the typographical error pop-up can only be displayed from either
Update Individual Agreement window or an Update Aggregate Agreement window.
Regardless of which type of agreement record is being updated, the pop-up is virtually
same. The typographical error pop-up number varies based on the type of agreement r
being updated. Additionally, the pop-up titles and wording may deviate from one pop-uj
another. Therefore, since handling typographical errors on updates to individual or agg
agreements are accomplished in the same manner from either pop-up, a sample typog
error pop-up is shown only once in the procedures.

Entries in the system are subject to front-end edits. If an error occurs or if required data is
omitted, a message maybe displayed on the message line or the error message may appear as
a pop-up. Error messages are displayed one at a time and are not displayed in any sequential
or hierarchical order. As an error is corrected, another error message may be displayed if a
record contains more than one error. All errors must be corrected before the system will
respond to the request action (elgvalid Date-MM-DD-YY, MM/DD/YY, MM DD YY,

MMDDYY, MMDDYYYY, MM-DD-YYYY).

Listed below is a an example of an error message pop-up. The Edit Pattern Validation Error
pop-up Eigure 10) is generated when the funds amount entered on the Add Individual
Agreement window is not entered consistent with the accepted format. The error message
pop-ups vary from window to window and depend on the type of data in error.

Edit Pattern Yalidation Error

Figure 10. Edit Pattern Validation Error pop-up  (Sample error message pop-up)

To respond to the error message pop-up:

* Click [OK] to close the error message pop-up. The pop-up disappears and returns you
to the window to correct the error.
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Using FAAD

This section presents the following topics:
Processing Agreements
Maintaining CFDA Data
Maintaining Recipient Names

Using Aliases
Searching For Department/Agency And Geographical Codes

Processing Suspense Records
Executing FAAD Reports

Processing Agreements

Updated 3/15/02

Agreements are considered the lifeline of FAAD and are used to track the CFDA program
numbers as well as the awardees. An agreement lists all the detail information about the
award given to an individual or organization. Several windows in FAAD are used in the
agreement function and provide data such as agreement lists and history information.

Agreements can be entered as aggregate or individual. An aggregate agreement is trag
the higher level program and awards the monies to an entity that is responsible for
administering the lower level program. It collects and reports data on an county aggreg
award basis. County Aggregate reporting consists mainly of entitlement payments to
individuals, loan guarantees, and direct insurance of risk. However, an individual agree
identifies a single recipient who will be responsible for carrying out the program objecti
It collects and reports data on an action-by-action basis. Most financial assistance awa
be reported on an individual award basis. An agreement can be modified and/or delete
following describes what constitute an aggregate or an individual agreement.

ax'vd Buisn

Example:

Aggregate Agreement This type of agreement is established with a higher level
organization who will administer a specific program. For instance, an aggregate agreement
may be made with the State of Georgia, Office of Social Welfare, to administer the state’s
food stamp program. The State of Georgia will allocate program monies to each county for
distribution to smaller municipalities to carry out the objectives of the overall program. In a
case such as this, FAAD will only track the monies awarded to the State of Georgia and not
each county/municipality.

Example:

Individual Agreement - This type of agreement is established with the individual recipient
that will administer a specific program. For instance, an individual agreement may be made
with Mercantile University, Department of Scientific Research to reduce the pollution and
improve the quality of living resources in the River Basin Bay. In a case such as this, FAAD
will track the monies awarded to the individual recipient, Mercantile University, to carry out
the specific program/project.
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When an agreement is established online, regardless of its effective date, it is validated
against the current status of the CFDA number. If the CFDA number is inactive, the system
will not let you add the agreement. However, even though an existing agreement may be
associated with a CFDA number that has an inactive status, the system will permit you to
modify/update that agreement.

The CFDA number defines the rules in which the agreement is validated against during the
online creation process. The CFDA number also defines which recipient and assistance type
codes you can enter on the agreement. Additionally, the CFDA number dictates if the
agreement can be aggregate or individual. If the CFDA number was established with an
individual award type, then you can only establish an individual agreement associated with
that CFDA number. On the other hand, if the CFDA number was established with an
aggregate award type, then you can only establish an aggregate agreement associated with
that CFDA number. However, when you add an agreement associated with a CFDA number
that was established with an award typeBdth” the system alerts you with a pop-up
prompting you to select whether the agreement should be aggregate or individual.

There are certain business decisions that mandate certain limitations on agreement
processing. A department will have an averagéOaind a maximum af00 agencies. An

agency will have an average®and a maximum a30 CFDA number records. A CFDA

number will have an average ®and a maximum d30 summary level agreements.

Additionally, new agreements entered online cannot have the obligation date greater than two
quarters from the current FAAD quarter. It also can not be more than 5 years prior than the
current date. The effective quarter must be the same quarter as the obligation date.

Effective Obligation Obligation
Quarter Month Year
1 10, 11, 12 Effective Fiscal Year + 1
2 01, 02, 03 Effective Fiscal Year
3 04, 05, 06 Effective Fiscal Year or

Effective Fiscal Year + 1

4 07, 08, 09 Effective Fiscal Year or
Effective Fiscal Year + 1

The system processes agreement entries Sydars prior to the current date and/or up to
two quarters in the future.

Business decisions have been made that govern when agreements can be deleted. The
following information describes how deleted agreements are handled in FAAD:

» If the agreemenirfdividual or aggregatghas not been reported to Census, the
agreementan bedeleted from the system.

* If an aggregate agreement record has been reported to Censcangoudelete the
agreement from the system. The error message p@gipgate Agreement Has
Been Reported To Census And Can Not Be Deleted is displayed.

» If an individual agreement has been reported to Census, the agreement can logically be
deleted. The delete process creates a “reversal record” which zeros-out the the Federal
and non-Federal amounts for the agreement. Additionally, the delete process sets the
Action Type Codeif both the summary and transaction recQrtsD.
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* Anindividual agreement that has been logically deleted maintains its history in FAAD
and will be displayed on the Agreement List window. This window allows you to
select a deleted individual agreement and all tool buttons will be enableDi@Eay
AgreementDisplay History ListHistory Detail Update andDeletq. If the agreement
has been previously deleted, you cannot make any updates or again delete the
agreement. Therefore, if you select the Delete or Update tool button, the error message
pop-upindividual Agreement Has Been Deleted. Can Not Update Or Delete The
Agreement is displayed. You will be able to display the individual agreement detail
and the agreement’s history. For detail information,8ggaying An Individual
Agreement Record , Displaying An Individual Agreement History Detail Record , and
Displaying Agreement History List Data

For instructions on processing agreements, see:
Adding An Individual Agreement Record

Adding An Aggregate Agreement Record

Modifying/Updating An Individual Agreement Record

Modifying/Updating An Aggregate Agreement Record

Displaying An Individual Agreement Record

Displaying An Agaregate Agreement Record

Displaying An Individual Agreement History Detail Record

Displaying An Agagregate Agreement History Detail Record

Displaying Agreement History List Data

Deleting An Individual Or Aggregate Agreement Record

G
a
-
5
o

Adding An Individual Agreement Record

To add an individual agreement record:

1. Atthe Federal Assistance Award Data (FAAD) System banner windigurd 4 ),
selectmaintenance > Agreement . The Select Department And Agency pop-up
(Figure 11) is displayed.

FADDOZ Select Department and Agency

Department: ll_
Agency: l_

Cancel ‘

Figure 11. Select Department And Agency pop-up  (FAD0O02)

2. Complete the Select Department And Agency fields as indicated sader
Department And Agency Pop-up Field Instructions
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1) Before an agreement record can be added in FAAD, it must first be associated with
a CFDA number under a specific department/age2jdy.the department and agency
codes are not known, cli¢gkancel] at the Select Department And Agency pop-up.

The List Department And Agency windoWwidure 41) is displayed. For information

on using the List Department And Agency window, Segrching For

Department/Agency And Geographical Codes . For information on the fields, seat
Department And Agency Window Field Instructions

. After completing the Select Department And Agency pop-up fields, [gliet] . The

Agreement List windowHjgure 12) is displayed.
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Figure 12. Agreement List window

This window displays all CFDA number records for the specific department and
agency entered. For an explanation of the Agreement List fieldggssenent List
Window Field Instructions . To view all of the fields on the bottom portion of the
window, click|i| or|£| to move the window.

. Select a CFDA number/program name from the list box at the upper portion of the

Agreement List window. Sele&lit > Add Agreement .

At the Agreement List window, you can also set the system to allow entering multiple
or single individual agreement records.

» Selectoptions > Single to add one individual agreement record at a time.

» Selectoptions > Multiple to add more than one individual agreement record for
the same department/agency and CFDA at a time. After each individual
agreement record is completed, selglet> Save to save the record. The system
refreshes the window and displays another Add Individual Agreement window for
you to add. After all individual agreements have been entered, «j clo close

the Add Individual Agreement window. The system returns you to the Agreement
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List window (Figure 12) and the individual agreements added are displayed in the
bottom portion of the window.

5. If the CFDA number selected was established with the Award Typaatls™the
system displays the Select Agreement popRiguie 13) .

FADDO3Z Select Agreement Type

Select the type of agreement you would like to add.

Type Indicator
" Aggregate

O Indiwidual

.................................

OK Cancel

.................................

Figure 13. Select Agreement Type pop-up

This pop-up prompts you to select a type indicator. The pop-up defaults to
“Individual.” Click [Aggregate] to add an aggregate agreement. After the indicator
selected, clickOK]. The appropriate add agreement window is displayed.

G
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= If the selected CFDA number was established with the award typedagidual,” the

Note system automatically displays the Add Individual Agreement windkyurg 14 ). If
the selected CFDA number was established with the award typeggsegate’ the
system automatically displays the Add Aggregate Agreement wingigwe( 19 ).
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Figure 14. Add Individual Agreement window

6. To add an individual agreement, complete the Add Individual Agreement fields as
indicated undeAdd Individual Agreement Window Field Instructions

7. If the agreement being added is for a standard recipient coded(e.91, 06, or 2))
click ... | to display the Search Recipient Name popfigue 15).

FABOD4 Search Recipient Hame

Recipient Name: | |

Find Cancel

Figure 15. Search Recipient Name pop-up

8. Complete the Search Recipient Name fields as indicated 8adeh Recipient
Name Pop-up Field Instructions

9. After completing the Search Recipient Name fields, dfald] to search the database.
Click [Cancel] to close and remove the pop-up.

10. After the system search is completed, the results are displayed on the List Recipient
Name, Location, And Additional Info windovFigure 16 ).
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11.

Note

12.

Updated 3/15/02
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Figure 16. List Recipient Name, Location, And Additional Info window

For information on the fields, s&&t Recipient Name. Location. And Additional Info
Window Field Instructions

At the List Recipient Name, Location, And Additional Info winddsg(re 16 ), select
the recipient name, location, and additional descriptions from the Names, Locatio
Descriptions, and Additional Descriptions list boxes. Setett> Select & Return .

The system returns you to the Add Individual Agreement windkyuré 14 ) and the
selected recipient data is populated in the fields. The system also populates the
geographical data fields from the selected recipient name record.

G
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If you have a non-standard recipient, you may enter data in the Name, Location, and
Additional Description fields. However, youust select the geographical information
from data maintained in the system by accessing the List State/County/City/Zip/
Congressional District windowFigure 42 ). To display the List State/County/City/
Zip/Congressional District window, clic .. | next to the Congressional District field.

For instructions on using this window, s&sarching For A Geographical Code . For
information on the fields, seest State/County/City/Zip/Congressional District
Window Field Instructions

If you would like to view/verify the geographical information of the selected recipient
prior to adding it to the agreement record, seléat > Display Geographical

Information at the List Recipient Name, Location, And Additional Info window

(Figure 16)). The Display Geographical Information pop-@&ygre 17) is displayed.

To remove the pop-up, cligkancel] .
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FAGODZ Display Geographical Information

State: AL Congressional District: 90
County: MONTGOMERY
City Hame: MONTGOMERY

fip Code: 36101 - 0000

.................................

Figure 17. Display Geographical Information pop-up

13. Forest Service users can enter project detail data associated with an individual
agreement. Selettiew > Forest Service Project Details . The Forest Service Project
Details pop-upKigure 18).

FAFOD2 Forest Service Project Details

Institute Code Research Code Field Office Code
" Hen-Land Grants A
" 1890 Land Grants * hd
¢ Land Grants e
Project Description:
Amounts
Coop Amount: 0 Grant Amount: 4,
Appropriated Amount: 40 Reimbursable Amount: 0

Return Cancel ‘

Figure 18. Forest Service Project Details pop-up

14. Complete the Forest Service Project Details fields as indicated Esrdetr Service
Project Details Pop-up Field Instructions . After completing the fields, cliciReturn] .
If you do not want the project details data to become a part of the agreement record,
click [Cancel] .
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15.

16.

If you click [Exit] before you save the agreement to the FAAD database, the Save
Changes pop-up-igure 6) is displayed. Respond to the save changes pop-up as
indicated undegaving Data .

After completing all the fields, seleffle > Save. The agreement record is updated to
the FAAD database and is automatically populated to the bottom portion of the
Agreement List windowRjgure 12 ). To perform another action, select the appropriate
icon. To exit the system, all windows must be closed. At the FAAD menu, seédeet
Exit.

Adding An Aggregate Agreement Record

Note

Note

Updated 3/15/02

1.

5.

To add a aggregate agreement record:

At the Federal Assistance Award Data (FAAD) System banner wingigurd 4 ),
selectvaintenance > Agreement . The Select Department And Agency pop-up
(Figure 11) is displayed.

Complete the Select Department And Agency fields as indicated sader
Department And Agency Pop-up Field Instructions

Before an agreement record can be added in FAAD, it must first be associated w
CFDA number under a specific department/agency.

If the department and agency codes are not known, [Clickel] at the Select
Department And Agency pop-up. The List Department And Agency window
(Figure 41) is displayed. For information on using the List Department And Agenc
window, seeSearching For Department/Agency And Geographical Codes . For
information on the fields, segst Department And Agency Window Field

Instructions .
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After completing the Select Department And Agency pop-up fields, [¢lied] . The
Agreement List windowRjgure 12) is displayed. This window displays all CFDA
number records for the specific department and agency entered.

Select a CFDA number/program name from the list box at the upper portion of the
Agreement List window. Sele&lit > Add Agreement ..

At the Agreement List window, you can also set the system to allow entering multiple
or single aggregate agreement records.

» Selectoptions > Single to add one aggregate agreement record at a time.

» Selectoptions > Multiple to add more than one aggregate agreement record for
the same department/agency and CFDA at a time. After each aggregate agreement
record is completed, selegte > Save to save the record. The system refreshes
the window and displays another Add Aggregate Agreement window for you to
complete. After all aggregate agreements have been enterec«j litkclose the

Add Aggregate Agreement window. The system returns you to the Agreement
List window (Figure 12 ) and the aggregate agreements added are displayed in the
bottom portion of the window.

If the CFDA number selected was established with the Award TypRadl™the
system displays the Select Agreement popRiguie 13) . This pop-up prompts you
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to select a type indicator. The pop-up defaultdndiVidual.” Click [Aggregate] to
add an aggregate agreement. After the indicator is selectedtickThe Add
Aggregate windowHRigure 19) is displayed.
R |
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Figure 19. Add Aggregate Agreement window

6. Complete the Add Aggregate Agreement fields as indicated wadetggregate
Agreement Window Field Instructions . To complete the geographical fields on the
Add Aggregate window, seleGo To > State And County List  or click ... |. The List

State/County/Congressional District windoRig(re 20) is displayed.
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Figure 20. List State/County/Congressional District window
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Note

8.
9.
10.
11.
12.

Updated 3/15/02

For information on the fields, séét State/CountyCongressional District Window
Field Instructions .

After selecting the geographical information from the List State/County/Congressional
District window, selecEdit > Select And Return . The system returns you to the Add
Aggregate window and the selected geographical data is in populated in the State,
County, and Congressional District fields.

Because both the State and County list boxes provide for limited scroll capability, you
may encounter a confirm scroll pop-up if information is highlighted and you try to
scroll past the limit of records. For information on using the scroll pop-up, see
Scrolling Records .

At the List State/County/Congressional District window, you can limit the search by
searching on specific geographical data. Select a state from the State list box and select
View > Search County or click #|. The Search County pop-upidure 21) is

displayed.

FA4004 Search County

County Code:

County Hame:
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Find Cancel

Figure 21. Search County pop-up

Complete the Search County fields as indicated useleth County Pop-up Field
Instructions .

After completing the Search County pop-up fields, clitkd] . The County list box
on the List State/County/Congressional District windeiute 20 ) displays the
geographical data based on the search criteria entered. 4 Jick + | until you

display the desired geographical data.

If you click [Exit] before you save the agreement to the FAAD database, the Save
Changes pop-ugrigure 6 ) is displayed. Respond to the save changes pop-up as
indicated undegaving Data .

After completing all the fields, selegfle > Save. The agreement record is updated to
the FAAD database and is automatically populated to the bottom portion of the
Agreement List windowRjgure 12 ). To perform another action, select the appropriate
icon. To exit the system, all windows must be closed. At the FAAD menu, sédeet
Exit.
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Modifying/Updating An Individual Agreement Record

To modify/update an individual agreement record:

= FAAD displays a typographical error pop-tfgQire 9) when you access an individual

Noe - ggreement record to modify/update and the agreement has already been reported to Census. If
the modification/update being made is due to a typographical error in the original agreement
or a subsequent update(s) to the agreement, when you rg¢sgsindnformation indicating
Typo Erroris carried in the history. For detail information on using the typographical error
pop-up, se&sing The Typographical Error Pop-up

1. Atthe Federal Assistance Award Data (FAAD) System banner wingigurd 4 ),
selectvaintenance > Agreement . The Select Department And Agency pop-up
(Figure 11) is displayed.

2. Complete the Select Department And Agency fields as indicated sader
Department And Agency Pop-up Field Instructions

= If the department and agency codes are not known, [Clickel] at the Select

Note Department And Agency pop-up. The List Department And Agency window
(Figure 41) is displayed. For information on using the List Department And Agency
window, seeSearching For Department/Agency And Geographical Codes . For
information on the fields, seagst Department And Agency Window Field
Instructions .

3. After completing the Select Department And Agency pop-up fields, [¢lied] . The
Agreement List windowRjgure 12) is displayed. This window displays all CFDA
number records for the specific department and agency entered.

4. Select a CFDA number/program name from the list box at the upper portion of the
Agreement List window. After a CFDA is selected, the agreement(s) associated with
the selected CFDA is populated in the bottom portion of the window.

5. For an explanation of the Agreement List fields, s@eement List Window Field
Instructions . To view all of the fields on the bottom portion of the window, c|1|<

or|£| to move the window.

6. Atthe Agreement List windowr(gure 12) you can sort the display of the agreement
data in a certain order at the bottom portion of the window. Seleet> Search And
Sort Agreements . The Search And Sort Agreements pop-Eigufe 22 ) is displayed.
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. Complete the Search And Sort Agreements fields as indicated Suwdett And Sort

. After completing the Search And Sort Agreements fields, ¢#iol] to search the

. To modify/update an individual agreement, select the agreement from the bottom
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Figure 22. Search And Sort Agreements pop-up

Agreements Pop-up Field Instructions

database. CliciCancel] to close and remove the pop-up. The system returns you t
the Agreement List window. The bottom portion of the window is populated with t
agreements based on the search and sort criteria entered at the Search And Sort
Agreements pop-up.

avvd buisn

portion of the Agreement List window. Sele&dit > Update Agreement or click == .
The Update Individual Agreement windo®idure 23) is displayed.
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Figure 23. Update Individual Agreement window
10. Modify/update the Update Individual Agreement fields as indicated wxuer

Individual Agreement Window Field Instructions andUpdate Individual Agreement
Window Field Instructions

11. If you click [Exit] before you save the modifications to the FAAD database, the Save
Changes pop-up-igure 6) is displayed. Respond to the save changes pop-up as
indicated undegaving Data .

12. After modifying the fields, selectile > Save. The modified agreement record is
updated to the FAAD database and is automatically populated to the bottom portion of
the Agreement List windowF{gure 12). If you decreased/increased fund amounts, the
modified amounts are reflected in the appropriate field(s) on the Agreement List
window.

13. At the Update Individual Agreement windo®idure 23 ), you can display a pop-up
that identifies information on when the agreement was last updated. Gelest ast
Updated . The Individual Agreement Last Update Information popHigufe 24 ) is
displayed.
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Note

Modifying/Updating An Aggregate Agreement Record

=

Note

Note

Updated 3/15/02

FAFODS Individual Agreement Last Update Information

Last Update Date: 01-06-2000
Last Update Time: 13:06:42
User ID: HF268
Close

Figure 24. Individual Agreement Last Update Information pop-up

The pop-up provides the last update date, last update time, and the user ID of the
person that made the update. To remove the pop-up,[Click] .

You can also view the last update information pop-up from an Update Aggregate

Agreement window. The pop-up is the same, except for the window number and name.

Therefore, the pop-up is displayed only once in the procedure.

14. To perform another action, select the appropriate icon. To exit the system, all win
must be closed. At the FAAD menu, seleit > Exit .

To modify/update an aggregate agreement record:

FAAD displays a typographical error pop-ufigtire 9) when you access an aggregate
agreement record to modify/update and the agreement has already been reported to C
the modification/update being made is due to a typographical error in the original agree
or a subsequent update(s) to the agreement, when you rg¢sgsindnformation indicating
Typo Error is carried in the history. For detail information on using the typographical error
pop-up, se&sing The Typographical Error Pop-up

1. Atthe Federal Assistance Award Data (FAAD) System banner wingigurd 4 ),
selectvaintenance > Agreement . The Select Department And Agency pop-up
(Figure 11) is displayed.

2. Complete the Select Department And Agency fields as indicated sader
Department And Agency Pop-up Field Instructions

If the department and agency codes are not known, [Clickel] at the Select
Department And Agency pop-up. The List Department And Agency window

(Figure 41) is displayed. For information on using the List Department And Agency
window, seeSearching For Department/Agency And Geographical Codes . For
information on the fields, seagst Department And Agency Window Field

Instructions .

3. After completing the Select Department And Agency pop-up fields, [¢lied] . The
Agreement List windowRjgure 12) is displayed. This window displays all CFDA
number records for the specific department and agency entered.
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4. Select a CFDA number/program name from the list box at the upper portion of the
Agreement List window. After a CFDA is selected, the agreement(s) associated with
the selected CFDA is populated in the bottom portion of the window.

5. To modify/update an aggregate agreement, select the agreement from the bottom
portion of the Agreement List window. Selegdit > Update Agreement or click == .
The Update Aggregate Agreement windagre 25) is displayed.
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Figure 25. Update Aggregate Agreement window

6. Modify/update the Update Aggregate Agreement fields as indicated addier
Agagregate Agreement Window Field Instructions andUpdate Aggregate Agreement
Window Field Instructions

7. If you click [Exit] before you save the modifications to the FAAD database, the Save
Changes pop-ugrigure 6) is displayed. Complete the save changes fields as indicated

underSaving Data .

8. After modifying the fields, selectile > Save. The modified agreement record is
updated to the FAAD database and is automatically populated to the bottom portion of
the Agreement List windowF{gure 12). If you decreased/increased fund amounts, the
modified amounts are reflected in the appropriate field(s) on the Agreement List
window.

9. You can display a pop-up that identifies information on when the agreement was last
updated. Seleatiew > Last Updated . The Individual Agreement Last Update
Information pop-upKigure 24) is displayed. The pop-up provides the last update date,
last update time, and the user ID of the person that made the update. To remove the
pop-up, click[Close] .

= When the pop-up is viewed from an Update Aggregate Agreement window, the
Note pop-up’s title is Aggregate Agreement Last Update. The pop-up is the same, except for
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the window number and name. Therefore, the pop-up is displayed only once in the
procedure.

10. To perform another action, select the appropriate icon. To exit the system, all windows
must be closed. At the FAAD menu, selei > Exit .
Displaying An Individual Agreement Record
To display an individual agreement record:

1. Atthe Federal Assistance Award Data (FAAD) System banner wingigurd 4 ),
selectvaintenance > Agreement . The Select Department And Agency pop-up
(Figure 11) is displayed.

2. Complete the Select Department And Agency fields as indicated sader
Department And Agency Pop-up Field Instructions

= If the department and agency codes are not known, at the Select Department And
Note Agency pop-up, clickCancel] . The List Department And Agency windoWidure 41)
is displayed. For information on using the List Department And Agency window,

Searching For Department/Agency And Geographical Codes . For information on the
fields, seeList Department And Agency Window Field Instructions

3. After completing the Select Department And Agency pop-up fields, [¢lied] . The
Agreement List windowRjgure 12) is displayed. This window displays all CFDA
number records for the specific department and agency entered.
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4. Select a CFDA number/program name from the list box at the upper portion of th
Agreement List window. After a CFDA is selected, the agreement(s) associated
the selected CFDA is populated in the bottom portion of the window.

5. Select the agreement to be displayed from the bottom portion of the Agreement
window. SeleciGo To> Agreement Detail or click = to display the Display

Individual Agreement windowHgure 26 ).
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Figure 26. Display Individual Agreement window

6. For an explanation of the Display Individual Agreement window fieldsAsee
Individual Agreement Window Field Instructions

On the Display Individual Agreement window, the Action field displays one of the
following codes:

A New Assistance Award
C Continuation
R Revision

7. After viewing the agreement, seleggife > Close . To perform another action, select the
appropriate icon. To exit the system, all windows must be closed. At the FAAD menu,

selectFile > Exit .
Displaying An Aggregate Agreement Record

To display an aggregate agreement record:

1. Atthe Federal Assistance Award Data (FAAD) System banner wingigurd 4 ),
selectmaintenance > Agreement . The Select Department And Agency pop-up
(Figure 11) is displayed.

2. Complete the Select Department And Agency fields as indicated sader
Department And Agency Pop-up Field Instructions

= If the department and agency codes are not known, [Clickel] at the Select
Note Department And Agency pop-up. The List Department And Agency window
(Figure 41) is displayed. For information on using the List Department And Agency
window, seeSearching For Department/Agency And Geographical Codes . For
38 Processing Agreements
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information on the fields, segst Department And Agency Window Field
Instructions .

3. After completing the Select Department And Agency pop-up fields, [¢lied] . The
Agreement List windowHjgure 12) is displayed. This window displays all CFDA
number records for the specific department and agency entered.

4. Select a CFDA number/program name from the list box at the upper portion of the
Agreement List window. After a CFDA is selected, the agreement(s) associated with
the selected CFDA is populated in the bottom portion of the window.

5. Select the agreement to be displayed from the bottom portion of the Agreement List
window. SeleciGo To > Agreement Detail or click 53 to display the Display

Aggregate Agreement windowigure 27).
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Figure 27. Display Aggregate Agreement window

6. For an explanation of the Display Aggregate Agreement window fieldgdsee
Aggregate Agreement Window Field Instructions

7. After viewing the agreement, selggife > Close . To perform another action, select the
appropriate icon. To exit the system, all windows must be closed. At the FAAD menu,
selectFile > Exit .

Displaying An Individual Agreement History Detail Record
To display an individual agreement history detail record:

1. Atthe Federal Assistance Award Data (FAAD) System banner wingigurd 4 ),
selectmaintenance > Agreement . The Select Department And Agency pop-up
(Figure 11) is displayed.
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2. Complete the Select Department And Agency fields as indicated sader
Department And Agency Pop-up Field Instructions

= If the department and agency codes are not known, [Clickel] at the Select

Note Department And Agency pop-up. The List Department And Agency window
(Figure 41) is displayed. For information on using the List Department And Agency
window, seeSearching For Department/Agency And Geographical Codes . For
information on the fields, seagst Department And Agency Window Field
Instructions .

3. After completing the Select Department And Agency pop-up fields, [clied] . The
Agreement List windowRjgure 12) is displayed. This window displays all CFDA
number records for the specific department and agency entered.

4. Select a CFDA number/program name from the list box at the upper portion of the
Agreement List window. After a CFDA is selected, the agreement(s) associated with
the selected CFDA is populated in the bottom portion of the window.

5. Select the agreement to be displayed from the bottom portion of the Agreement List
window. SeleciGo To > History Detail or click [] to display the Individual

Agreement History windowF{gure 28).
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Figure 28. Individual Agreement History window

If multiple agreements are available, cl|ﬂ| to display the next history detail record.
Click |44| to return to the previous history detail record.

6. For an explanation of the Individual Agreement History window fields see,
Add Individual Agreement Window Field Instructions
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7.

On the Individual Agreement History window, the Action field displays the one of the
following codes:

A New Assistance Award
C Continuation

R Revision

D Deletion

The Reported To Census Date field displays the date the transaction was reported to
Census and is only displayed when the quarter ends and the agreement data has been
forwarded to Census.

After viewing the history detail, seleftle > Close . To perform another action, select
the appropriate icon. To exit the system, all windows must be closed. At the FAAD
menu, seleckile > Exit .

Displaying An Aggregate Agreement History Detail Record

Note

Updated 3/15/02

To display an aggregate agreement history detail record:

1.

At the Federal Assistance Award Data (FAAD) System banner wingigurd 4 ),
selectvaintenance > Agreement . The Select Department And Agency pop-up
(Figure 11) is displayed.

Complete the Select Department And Agency fields as indicated sader
Department And Agency Pop-up Field Instructions

G
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If the department and agency codes are not known, [Clickel] at the Select
Department And Agency pop-up. The List Department And Agency window
(Figure 41) is displayed. For information on using the List Department And Agenc
window, seeSearching For Department/Agency And Geographical Codes . For
information on the fields, segst Department And Agency Window Field

Instructions .

After completing the Select Department And Agency pop-up fields, [¢lied] . The
Agreement List windowRjgure 12) is displayed. This window displays all CFDA
number records for the specific department and agency entered.

Select a CFDA number/program name from the list box at the upper portion of the
Agreement List window. After a CFDA is selected, the agreement(s) associated with
the selected CFDA is populated in the bottom portion of the window.

Select the agreement to be displayed from the bottom portion of the Agreement List
window. SelectGo To > History Detail or click 7] to display a window similar to the

Display Aggregate Agreement windowidure 27 ). The history detail window and the
display window carry the same window number, FAPOO1, and display the same data
fields. However, the display and history detail windows titles’ are different. The
history detail window’s title is Aggregate Agreement History. Because of the
windows’ likeness, the Aggregate Agreement History window is not displayed. If
multiple agreements are available, cl|pp| to display the next history detail record.

Click |44| to return to the previous history detail record.
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6. For an explanation of the Display Aggregate Agreement window fieldagge,
Aggregate Agreement Window Field Instructions

The Reported To Census Date field displays the date the transaction was reported to
Census and is only displayed when the quarter ends and the agreement data has been
forwarded to Census.

7. After viewing the history detail, sele£gtle > Close . To perform another action, select
the appropriate icon. To exit the system, all windows must be closed. At the FAAD
menu, seleckile > Exit .

Displaying Agreement History List Data

To display agreement history list data:

1. Atthe Federal Assistance Award Data (FAAD) System banner wingigurd 4 ),
selectvaintenance > Agreement . The Select Department And Agency pop-up
(Figure 11) is displayed.

2. Complete the Select Department And Agency fields as indicated sader
Department And Agency Pop-up Field Instructions

= If the department and agency codes are not known, [Clickel] at the Select

Note Department And Agency pop-up. The List Department And Agency window
(Figure 41) is displayed. For information on using the List Department And Agency
window, seeSearching For Department/Agency And Geographical Codes . For
information on the fields, segst Department And Agency Window Field
Instructions .

3. After completing the Select Department And Agency pop-up fields, [¢lied] . The
Agreement List windowHjgure 12) is displayed. This window displays all CFDA
number records for the specific department and agency entered.

4. Select a CFDA number/program name from the list box at the upper portion of the
Agreement List window. After a CFDA is selected, the agreement(s) associated with
the selected CFDA is populated in the bottom portion of the window.

5. Select the agreement to be displayed from the bottom portion of the Agreement List
window. SelecGo To> History List or click [#] to display the Agreement History List

window (Figure 29). If multiple agreements are available, cl[pb| to display the next
history detail record. Clic|44| to return to the previous history detail record.
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Deleting An Individual Or Aggregate Agreement Record

=

Note

Updated 3/15/02
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Figure 29. Agreement History List window

For an explanation of the Agreement History List window fields Ssgeement
History List Window Field Instructions

G
a
-
5
o

After viewing the history list, seleetile > Close . To perform another action, select th
appropriate icon. To exit the system, all windows must be closed. At the FAAD m
selectFile > Exit .

To delete an individual or aggregate agreement record:

If an aggregate agreement has already been reported to Census, you cannot delete the
agreement. When you seledit > Delete Agreement or click £/, the error message pop-up

Aggregate Agreement Has Been Reported To Census And Can Not Be Deleted is displayed.

If an individual agreement has been previously deleted, you cannot make any updates or
again delete the agreement. Therefore, if you select the Delete or Update tool button, the
error message pop-updividual Agreement Has Been Deleted. Can Not Update Or Delete

The Agreement is displayed. You will be able to display the individual agreement detail and
the agreement history.

1.

At the Federal Assistance Award Data (FAAD) System banner wingigurd 4 ),
selectmaintenance > Agreement . The Select Department And Agency pop-up
(Figure 11) is displayed.

Complete the Select Department And Agency fields as indicated sader
Department And Agency Pop-up Field Instructions

43
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= If the department and agency codes are not known, [Clickel] at the Select

Note Department And Agency pop-up. The List Department And Agency window
(Figure 41) is displayed. For information on using the List Department And Agency
window, seeSearching For Department/Agency And Geographical Codes . For

information on the fields, segst Department And Agency Window Field
Instructions .

3. After completing the Select Department And Agency pop-up fields, [¢lie#] . The
Agreement List windowRgure 12) is displayed. This window displays all CFDA
number records for the specific department and agency entered.

4. Select a CFDA number/program name from the list box at the upper portion of the
Agreement List window. After a CFDA is selected, the agreement(s) associated with
the selected CFDA is populated in the bottom portion of the window.

5. Select either the individual or aggregate agreement to be deleted from the bottom
portion of the Agreement List window. Selétit > Delete Agreement or click Z%/. A

confirm delete pop-up(gure 7) is displayed.

= The confirm delete pop-up used in this procedure is a sample deriving from the List
Note CFDA window.

6. To delete the agreement record, cliok] on the confirm delete pop-up. For more
information on using the confirm delete pop-up, Beleting Data .

7. SelectrFile > Close . To perform another action, select the appropriate icon. To exit the
system, all windows must be closed. At the FAAD menu, sellect Exit .

Maintaining CFDA Data

The Catalog of Federal Domestic Assistance (CFDA) is a Governmentwide collection of
Federal programs, projects, services, and activities which provide assistance or benefits to the
American public. The CFDA contains financial and nonfinancial assistance programs
administered by departments and organizations of the Federal government.

The CFDA program number is a 5-digit unique identification which describes the type of
program, assistance, project, or service for a specific Federal entity. The first two digits
identify the Federal department that administers the program, and the last three numbers are
assigned in numerical sequence. To maintain its uniqueness, the CFDA program number will
never be changed or reused for another type of program. The CFDA program title is the
descriptive name given to a program; however, the popular name, which may be less
descriptive than the program title, is the name by which the program is commonly known or
most often used by the applicant and/or Federal agency. Therefore, to ensure consistency in
program names, the official program name should be used when entering a CFDA program
number in FAAD.

The CFDA number is an integral link in the FAAD processing chain. When
modifying/updating the CFDA number record, certain fields are protected and cannot be
changed. One such field is the CFDA Number. Because the CFDA number is initially
established and maintained in the Catalog, which is published by the General Services
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Administration, it is essential that the number not be changed in FAAD. This assures the
uniqueness and integrity of the CFDA number. However, a CFDA number record may be
deleted in FAAD if an agreement is not associated with the CFDA number. If an agreement is
tied to the CFDA, the CFDA&annotbe deleted; the CFDA number record’s status can be
changed to “Inactive” to prohibit any further activity against the CFDA number.

A CFDA program number can become active in one period, but inactive in another. It can
also be renewed from year to year. A CFDA number award type can be aggregate, individual,
or both. For example, a CFDA program number award type can be ideniifidddual’ for

the 1st Quarter and changed sggregaté for the 2nd Quarter.

For instructions on maintaining CFDA numbers, see:
Adding A CFDA Number Record

Modifying/Updating A CEFDA Number Record

Deleting A CEDA Number Record

Adding A CFDA Number Record

Note

Note

Updated 3/15/02

To add a CFDA number record:

1.

At the Federal Assistance Award Data (FAAD) System banner wingigurd 4 ),
selectvaintenance > CFDA . The Select Department And Agency pop-Bigure 11) is
displayed.

Because the Select Department And Agency pop-up is handled in the same man
is shown only once in the procedure. Except for the pop-up number and different
wording on one of the buttons, the pop-up is virtually the same. To view a copy 0
pop-up, se@dding An Individual Agreement Record

&
a
. |
3
5

Complete the Select Department And Agency fields as indicated sader
Department And Agency Pop-up Field Instructions

Before a CFDA number record can be added in FAAD, it must first be associated with
a specific department/agency.

If the department and agency codes are not known, [Clickel] at the Select
Department And Agency pop-up. The List Department And Agency wingigwé

41) is displayed. For information on using the List Department And Agency window,
seeSearching For Department/Agency And Geographical Codes . For information on
the fields, seeist Department And Agency Window Field Instructions

After completing the fields, clicfoK]. The List CFDA window Eigure 30) is
displayed.
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Figure 30. List CFDA Window

This window displays all CFDA number records for the specific department and
agency entered.

4. At the List CFDA window, seleatdit > Add . The Add CFDA windowKigure 31) is
displayed.
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Figure 31. Add CFDA window
= At the List CFDA window, you can also set the system to allow entering multiple or

Note single CFDA number records.
» Selectoptions > Single to add one CFDA number record.

» Selectoptions > Multiple to add more than one CFDA number record for the
same department/agency.

The Options feature facilitates entering multiple records without having to repeat the
previous steps every time a each record is entered. After a CFDA number record is
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saved and updated to the FAAD database, the system automatically displays a blank

Updated 3/15/02

Add CFDA window for completion.

5. Complete the Add CFDA fields as indicated unaés CFDA Window Field
Instructions .

At any time during the entry process, you can access help for a field by piesking

6. If you click [Exit] before you update the CFDA number record to the FAAD database,
the Save Changes pop-ufigire 6) is displayed. Respond to the save changes pop-up

as indicated undegaving Data .

7. After completing the fields, seleflle > Save. The CFDA number record is updated to

the FAAD database. To perform another action, select the appropriate icon.

system, all windows must be closed. At the FAAD menu, sellect Exit .

Modifying/Updating A CFDA Number Record
To modify/update a CFDA number record:
1. Atthe Federal Assistance Award Data (FAAD) System banner wingigurd 4 ),

selectvaintenance > CFDA . The Select Department And Agency pop-Bigure 11)

is displayed.

2. Complete the Select Department And Agency fields as indicated sader
Department And Agency Pop-up Field Instructions

3. After completing the fields, clicfoK]. The List CFDA window Kigure 30) is

displayed. This window displays all CFDA number records for the specific depart

and agency entered.

4. At the List CFDA window, select the CFDA number record to be modified/updatet

and seleckedit > Update . The Update CFDA windowrigure 32) is displayed.
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Figure 32. Update CFDA window

To exit the

avr7/4 Buisn

5. Modify/update the Update CFDA fields as indicated umdierCFDA Window Field

Instructions andUpdate CFDA Window Field Instructions

Maintaining CFDA Data
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6. After modifying/updating the fields, selegte > Save to save the changes and update
the FAAD database. The system returns you to the the List CFDA wiRdove(30 ).
To perform another action, select the appropriate icon. To exit the system, all windows
must be closed. At the FAAD menu, seleit > Exit .

Deleting A CFDA Number Record

To delete a CFDA number record:

1. Atthe Federal Assistance Award Data (FAAD) System banner wingigurd 4 ),
selectvaintenance > CFDA . The Select Department And Agency pop-Bigure 11) is
displayed.

2. Complete the Select Department And Agency fields as indicated sader
Department And Agency Pop-up Field Instructions

3. After completing the fields, clicfoK]. The List CFDA window Kigure 30) is
displayed. This window displays all CFDA number records for the specific department
and agency entered.

4. At the List CFDA window, select the CFDA number record to be deleted and select
Edit > Delete . A confirm delete pop-upF{gure 7) is displayed.

= The confirm delete pop-up used in the procedures is a sample deriving from the List
Note CFDA window.

5. To delete the CFDA number record, clic] on the confirm delete pop-up. For more
information on using the confirm delete pop-up, Beleting Data .

= If the CFDA number has an associated agreement, a pop-up is displayed advising that

Note the CFDA number record cannot be deleted. Since the CFDA number record cannot be
deleted, you can modify the record to change the status to “Inactive.” This prohibits
any further activity against the CFDA number.

6. After deleting the CFDA number record, the system returns you to the List CFDA
window. If you cancel the delete, the List CFDA window is displayed with the
selected record highlighted.

7. To perform another action, select the appropriate icon. To exit the system, all windows
must be closed. At the FAAD menu, seleit > Exit .

Maintaining Recipient Names

Recipient names maintained in FAAD identify individuals, organizations, and government
entities with active as well as inactive award records. The recipient name is the name of the
individual or organization that have been granted an assistance award. Recipient names are
maintained in FAAD as either “standard” or “non-standard” recipients, based on the
applicable recipient code in the recipient name record. The following illustrations provide the
standard and non-standard recipient codes.
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Standard Recipient Codes/Descriptions

00 State Government

01 County Government

06 State Controlled Institutions of Higher
Education

20 Private Higher Education Institution

Non-Standard Recipient Codes/Descriptions

02 Municipal or Township Government
04 Special District Government

05 Independent School District

11 Indian Tribe

12 Non-profit Agency

21 Individual

22 Profit Organization

23 Small Business

25 All Other

To ensure consistency/standardization in adding recipient names in FAAD, a recipient
one or more of the above-mentioned standard recipient codes in its macsirdse the
standard recipient name that has been previously established in FAAD.

In addition to maintaining recipient names in FAAD, the system also tracks/monitors
“aliases.” Aliases are names that an organization/government entity may also be know
but is not considered the official name. For example, a university located in Mills Road,
Wisconsin is officially known as Cresmont University. However, the university is also
unofficially referred to as Crest Univ. or CU. These would be considered the aliases. B3
users do not access the system to update their FAAD data. Therefore, they do not have
to the appropriate tables to verify standard recipient names, and their transmissions may
include aliases. If this occurs on records that are standard recipients, system edits will
validate the aliases to determine the standard recipient name and update the record with a
standard namd&here is no limit to the number of aliases an organization or a

government entity can have in its recipient name record Aliases are maintained by
authorized OCFO personnel and certain personnel at NFC.

Qvvd Buisn

A recipient name record can be established with multiple recipient locations and additional
descriptions.

For instructions on maintaining recipient names, see:
Adding A Recipient Name Record

Modifying/Updating A Recipient Name Record

Deleting A Recipient Name Record
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Adding A Recipient Name Record
To add a recipient name record:

1. Atthe Federal Assistance Award Data (FAAD) System banner wingigurd 4 ),
selectvaintenance > Recipient Name . The Search Recipient pop-upglre 36) is
displayed. Clici{Cancel] . The Recipient Name windowi§ure 33) is displayed.

Fie Eil e aTp weie Hob
ey .

e S 7 A

Fregsesi Typa:

Fruqursd Hasor

Lawi Uystsied

L D Tire

180 TH L Ba R
Figure 33. Recipient Name window
= The Search Recipient pop-up is used primarily to search for an existing recipient name
Note and not for adding a recipient name. For information on completing the Search

Recipient fields, seBearch Recipient Pop-up Field Instructions

2. Complete the Recipient Name window field as indicated uRdepient Name
Window Field Instructions

3. After the cursor is positioned in the Recipient Name field and you start typing the
recipient namefAdd] and[Clear] are enabled. After the recipient name is entered,
click [Add] . The Recipient Location Description windofigure 34 ) is displayed.
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Figure 34. Recipient Location Description window

= If an error is made while entering the recipient name, at any point during the proc
Note click [Clear] . [Clear] refreshes the window and allows you to retype the recipient
name.

avvd buisn

4. Complete the Recipient Location Description window fields as indicated under
Recipient Location Description Window Field Instructions

5. After the the Recipient Location Description window fields have been completed,
selectEdit > Add or at the Recipient Location Description window, cligkd] to save
the data and update the FAAD database. To perform another action, select the
appropriate icon. To exit the system, all windows must be closed. At the FAAD menu,
selectFile > Exit .

= If an error is made while entering the recipient name record, at any point during the
Note process, clickClear] . [Clear] refreshes the window and allows you to retype the data.

6. You can add an additional description to the recipient name record by seleecting
Additional Descriptions . The Recipient Additional Description windoW®idure 35) is
displayed.
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Figure 35. Recipient Additional Description window

7. Complete the Recipient Additional Description fields as indicated uretégient
Additional Description Window Field Instructions

8. After the the Recipient Additional Description window fields have been completed,
selectEdit > Add or at the Recipient Additional Description window, cligkid] to
save the data and update the FAAD database. To perform another action, select the
appropriate icon. To exit the system, all windows must be closed. At the FAAD menu,
selectFile > Exit .

Modifying/Updating A Recipient Name Record

To modify/update a recipient name record:

1. Atthe Federal Assistance Award Data (FAAD) System banner wingigurd 4 ),
selectmaintenance > Recipient Name . The Search Recipient pop-upglre 36) is
displayed.

FA9003 Search Recipient

Mame: ||

Type: I

Find Cancel

Figure 36. Search Recipient pop-up
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Note

Note

Note
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2. Complete the Search Recipient pop-up fields as indicated 8adeh Recipient

Pop-up Field Instructions

To narrow the search, type as much of the recipient name as known. The Recipient
Names list box on the Recipient Name window only displays a limited number of
records that can be scrolled.

. After the Search Recipient pop-up fields are completed, [lio] . The Recipient

Name window Figure 37) is displayed with a limited number of recipient names
shown in the Recipient Names list box.
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Figure 37. Recipient Name window (Filled with data for modify/delete purposes)

If you determine that you do not want to perform the search, [Clicicel] . A blank
Recipient Name windowr(gure 33) is displayed.

If you completed the Search pop-up fields with a complete recipient name and type,
the Recipient Names list box displays only those recipient names beginning with the
name as typed and for that specific type code. For example, if you elnberisthna

in the Name field and2 in the Type field, the system search is limited to that data and
will display as many recipient names starting with Louisiana and a recipient type of
02.

. To modify/update only the recipient name, select the recipient name from the

Recipient Names list box. The selected name is highlighted and is populated in the
Recipient Name field under the Detail portion of the window [aipdate] , [Delete] ,
and[Clear] becomes enabled. After the the recipient name is modified, sefest
Update or click [Update] to save the changes and update the FAAD database. To
perform another action, select the appropriate icon. To exit the system, all windows
must be closed. At the FAAD menu, sel&it > Exit .

After the recipient name is modified, the system adds the old recipient name to the list
of aliases associated with that recipient name.
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5. To modify/update the recipient location description, select the recipient name from the
Recipient Names list box. The selected name is highlighted and is populated in the
Recipient Name field under the Detail portion of the window [aipdate] , [Delete] ,
and[Clear] becomes enabled. Selea To > Recipient Locations . A completed
Recipient Location Description windowigure 38) is displayed.
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Figure 38. Recipient Location Description window (Filled with data for modify/delete
purposes)

The Location Descriptions list box lists all locations for the recipient name record.
After a location description is selected, the selected location is populated in the
Location Description field and the other fields on the window are enabled and can be
modified/updated. AlsqUpdate] , [Delete], and[Clear] becomes enabled.

Modify/update the appropriate fields as indicated umR#eipient Location

Description Window Field Instructions

= The geographical information fields are protected can not be modified.
Note

To perform another action, select the appropriate icon. To exit the system, all windows
must be closed. At the FAAD menu, seleit > Exit .

6. To modify/update a recipient additional description, at the Recipient Location

Description window Figure 38 ) selectGo To > Additional Descriptions . A completed
Recipient Additional Description windowFigure 39) is displayed.
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Figure 39. Recipient Additonal Description window (Filled with data for modify/delete
purposes)

The Additional Descriptions list box lists all descriptions for the recipient name re
for the specific location selected. Select the additional description from the Additis
Descriptions list box. The selected name is highlighted and is populated in the
Additional Description field under the Detail portion of the window pndiate] ,

[Delete] , and[Clear] becomes enabled. Modify/update the Additional Description fig
as indicated undetecipient Additional Description Window Field Instructions . To
perform another action, select the appropriate icon. To exit the system, all windo
must be closed. At the FAAD menu, seleité > Exit .

avvd baisp

Deleting A Recipient Name Record

Updated 3/15/02

To delete a recipient name record:

1. Atthe Federal Assistance Award Data (FAAD) System banner wingigurd 4 ),
selectvaintenance > Recipient Name . The Search Recipient pop-upglre 36) is
displayed.

2. Follow instructions provided in Steps 2 and 3 undetifying/Updating A Recipient

Name Record to use the Search Recipient pop-Bigyre 36 ) and the Recipient Name
window (Figure 37).

3. To delete only the recipient name, select the recipient name from the Recipient Names

list box. The selected name is highlighted and is populated in the Recipient Name field
under the Detail portion of the window. After your cursor is positioned in the field,
[Update] , [Delete] , and[Clear] becomes enabled. Selelit > Delete or click [Delete].

A confirm delete pop-upF(gure 7) is displayed.

You must first respond to the pop-up. To delete the recipient name[aitick-or
additional information on the confirm delete pop-up, Beeting Data . To perform
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another action, select the appropriate icon. To exit the system, all windows must be
closed. At the FAAD menu, selegie > Exit .

4. To delete the recipient location description, select the recipient name from the
Recipient Names list box. The selected name is highlighted and is populated in the
Recipient Name field under the Detail portion of the window. After your cursor is
positioned in the fieldUpdate] , [Delete] , and[Clear] becomes enabled. Selext
To > Recipient Locations . A completed Recipient Location Description window
(Figure 38) is displayed.

The Location Descriptions list box lists all locations for the recipient name record.
After a location description is selected, the selected location is populated in the
Location Description field anfpdate] , [Delete], and[Clear] becomes enabled. Select
Edit > Delete or click [Delete]. A confirm delete pop-upF{gure 7) is displayed.

You must first respond to the pop-up. To delete the recipient location description
record, clicklOK]. For additional information on the confirm delete pop-up, see
Deleting Data . To perform another action, select the appropriate icon. To exit the
system, all windows must be closed. At the FAAD menu, sellect Exit .

5. To delete a recipient additional description, at the Recipient Location Description
window (Figure 38 ) selectGo To > Additional Descriptions . A completed Recipient
Additional Description windowHRgure 39) is displayed.

The Additional Descriptions list box lists all descriptions for the recipient name record
for the specific location selected. Select the additional description from the Additional
Descriptions list box. The selected name is highlighted and is populated in the
Additional Description field under the Detail portion of the window pndiate] ,

[Delete], and[Clear] becomes enabled. Selewiit > Delete or click &% /. A confirm

delete pop-upHigure 7) is displayed.

You must first respond to the pop-up. To delete the recipient additional description
record, clicklOK]. For additional information on the confirm delete pop-up, see
Deleting Data . To perform another action, select the appropriate icon. To exit the
system, all windows must be closed. At the FAAD menu, sellect Exit .

Using Aliases

FAAD tracks/monitors “aliases.” Aliases are names that an organization/government entity
may also be be known as, but is not considered the official name. For example, a university
located in Main Town, Alabama is officially known as Alabama College at Main Town.
However, the university is also unofficially referred to as Bama College or Bama C. These
would be considered the aliases. Batch users do not access the system to update their FAAD
data. Therefore, they would not have access to the appropriate tables to verify standard
recipient names, and their transmissions may include aliases. If this occurs on records that
are standard recipients, system edits will validate the aliases to determine the standard
recipient name and update the record with standard nigmee is no limit to the number

of aliases an organization or a government entity can have in its recipient name record.
Aliases are maintained by authorized OCFO personnel and certain personnel at NFC.
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For instructions on using aliases, see:

Adding An Alias To A Recipient Name Record

Modifying/Updating An Alias In A Recipient Name Record

Displaying An Alias(es) In A Recipient Name Record

Deleting An Alias In A Recipient Name Record

Adding An Alias To A Recipient Name Record

To add an alias to a recipient name record:

At the Federal Assistance Award Data (FAAD) System banner wingigurd 4 ),

selectvaintenance > Recipient Name . The Search Recipient pop-upglre 36) is
displayed.

Complete the Search Recipient pop-up fields as indicated 8adeh Recipient
Pop-up Field Instructions

To narrow the search, type as much of the recipient name as known. The Recipient

Names list box on the Recipient Name window only displays a limited number of
records that can be scrolled.

After the Search Recipient pop-up fields are completed, #iok] . The Recipient

Name window Figure 37) is displayed with a limited number of recipient names
shown in the Recipient Names list box.
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Select the recipient name from the Recipient Name list box. S&deri> Recipient
Aliases or click && . The Recipient Alias windowF{gure 40) is displayed.
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Figure 40. Recipient Alias window

1.
2.
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4.
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Complete the Recipient Alias fields as indicated umdeipient Alias Window Field
Instructions . The cursor is positioned in the Alias field for you to type the alias to be
added to the recipient name record.

After the the Recipient Alias window fields have been completed, [@litk to save

the data and update the FAAD database. To perform another action, select the
appropriate icon. To exit the system, all windows must be closed. At the FAAD menu,
selectFile > Exit .

Modifying/Updating An Alias In A Recipient Name Record

To modify/update an alias in a recipient name record:

1.

Note

At the Federal Assistance Award Data (FAAD) System banner wingigurd 4 ),
selectvaintenance > Recipient Name . The Search Recipient pop-upglre 36 ) is
displayed.

Complete the Search Recipient pop-up fields as indicated 8naeh Recipient
Pop-up Field Instructions

To narrow the search, type as much of the recipient name as known. The Recipient
Names list box on the Recipient Name window only displays a limited number of
records that can be scrolled.

After the Search Recipient pop-up fields are completed, #liok] . The Recipient
Name window Figure 37) is displayed with a limited number of recipient names
shown in the Recipient Names list box.

Select the recipient name from the Recipient Name list box. S&deri> Recipient
Aliases or click && . The Recipient Alias windowF{gure 40) is displayed.

At the Recipient Alias window, select the alias to be modified/updated from the
Aliases list box. The selected alias is populated in the Alias field for you to
modify/update.

Modify/update the Alias field as indicated un@ekcipient Alias Window Field
Instructions . After the the Alias field has been modified/updated, gligidate] to
save the data and update the FAAD database.

To perform another action, select the appropriate icon. To exit the system, all windows
must be closed. At the FAAD menu, selei > Exit .

Displaying An Alias(es) In A Recipient Name Record

To display an alias(es) in a recipient name record:

1.

Using Aliases

At the Federal Assistance Award Data (FAAD) System banner wingigurd 4 ),
selectvaintenance > Recipient Name . The Search Recipient pop-upglre 36) is
displayed.

. Complete the Search Recipient pop-up fields as indicated 8naeh Recipient

Pop-up Field Instructions
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= To narrow the search, type as much of the recipient name as known. The Recipient
Note Names list box on the Recipient Name window only displays a limited number of
records that can be scrolled.

3. After the Search Recipient pop-up fields are completed, [¢lict] . The Recipient
Name window Figure 37) is displayed with a limited number of recipient names
shown in the Recipient Names list box.

4. Select the recipient name from the Recipient Name list box. S&deri> Recipient
Aliases or click && . The Recipient Alias windowF{gure 40) is displayed.

5. After viewing the alias(es), seleffie > Close . To perform another action, select the
appropriate icon. To exit the system, all windows must be closed. At the FAAD menu,
selectFile > Exit .

Deleting An Alias In A Recipient Name Record

To delete an alias in a recipient name record:

1. Atthe Federal Assistance Award Data (FAAD) System banner wingigurd 4 ),
selectvaintenance > Recipient Name . The Search Recipient pop-upglre 36) is
displayed.

2. Complete the Search Recipient pop-up fields as indicated 8adeh Recipient
Pop-up Field Instructions

= To narrow the search, type as much of the recipient name as known. The Recipie
Note Names list box on the Recipient Name window only displays a limited number of
records that can be scrolled.

avvd buisn

3. After the Search Recipient pop-up fields are completed, [¢lict] . The Recipient
Name window Figure 37) is displayed with a limited number of recipient names
shown in the Recipient Names list box.

4. Select the recipient name from the Recipient Name list box. S&deri> Recipient
Aliases or click && . The Recipient Alias windowF{gure 40) is displayed.

5. At the Recipient Alias window, select the alias to be deleted from the Aliases list box.
The selected alias is populated in the Alias field for you to delete.

6. Delete the alias from Alias field as indicated un@etipient Alias Window Field
Instructions . Click [Delete] to delete the alias and update the FAAD database.

A confirm delete pop-up(gure 7) is displayed. You must first respond to the pop-up.
To delete the alias, clidoK]. For additional information on the confirm delete

pop-up, se®eleting Data .

7. To perform another action, select the appropriate icon. To exit the system, all windows
must be closed. At the FAAD menu, seleité > Exit .

Searching For Department/Agency And Geographical Codes

FAAD maintains both department/agency codes and names as well as geographical
information to facilitate the processing of data. Client agencies access to this data is limited
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to viewing and does not allow user intervention to add, modify/update, or delete
department/agency codes and geographical @alg.the Office of the Chief Financial
Officer (OCFO) personnel and certain authorized NFC personnel have access
capability to add, modify/update, and/or delete department/agency codes and
geographical data.

Due to the reporting requirements of FAAD data, it is critical that accurate geographical data
is contained in the recipient name records. This system-maintained geographical data is
comprehensive and includes the conterminous 48 states (CONUS) and the District of
Columbia. The geographical data also encompasses areas beyond the limits of the
conterminous U.S., (i.eoutside CONUSE This includes Alaska, Hawaii, Puerto Rico, and

the possessions and territories of the U.S. such as American Somoa, Guam, Midway Islands,
and Virgin Islands.

Therefore, to simplify the process when adding recipient-type data in FAAD, you merely
select the appropriate geographical information from a window. The selected data is then
automatically populated to the recipient location description record. This method of
processing ensures the accuracy and integrity of the geographical data contained in the
recipient name record as well as reported.

For instructions on searching for department/agency and geographical codes, see:

Searching For A Department/Agency Code

Searching For A Geographical Code

Searching For A Department/Agency Code
To search for a department/agency code:

1. Atthe Federal Assistance Award Data (FAAD) System banner wingigurd 4 ),
selectview > Dept/Agency . The List Department And Agency windowidure 41) is
displayed.
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Figure 41. List Department And Agency window

2. The fields on the List Department And Agency window do not allow for any data
entry. For information on the fields, seet Department And Agency Window Field
Instructions . The Department list box displays the available departments’ number
and names. Clic 4| or ¢ | to display and select the desired department. The

Agency list box displays the available agencies’ numbers and names for the sele
department. Clict 4 |or + | until you display the appropriate agency code and na

avvd buisn

= At this time, USDA is the only department in FAAD.

Note

3. To perform another action, select the appropriate icon. To exit the system, all windows
must be closed. At the FAAD menu, seleit > Exit .

Searching For A Geographical Code

To search for a geographical code:

1. Atthe Federal Assistance Award Data (FAAD) System banner wingigurd 4 ),
selectVview > Geographical . The List State/County/City/Zip/Congressional District
window (Figure 42) is displayed.
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Figure 42. List State/County/City/Zip Congressional District window

2. The fields on the List State/County/City/Zip/Congressional District window do not
allow for any data entry. For information on the fields, [9gteState/County/City
[Zip/Congressional District Window Field Instructions . The State list box displays the
available state codes and abbreviations. C 4 for ¢ | to display and select the

desired state. The County, City, Zip, Congressional District list box displays the
available county names, city codes, nhames, zip codes, and congressional districts for
the state selected from the State list box. C 4 kor + | until the desired

geographical data is displayed.

= Because both the State and County, City, Zip, Congressional District list boxes

Note provide for limited scroll capability, you may encounter a confirm scroll pop-up if
information is highlighted and you try to scroll past the limit of records. For
information on using the scroll pop-up, S&®olling Records .

3. At the List State/County/City/Zip/Congressional District window, you can limit the
search by searching on specific geographic data. Select a state from the State list box
and selecview > Search or click s|. The Search County/City pop-uRidure 43) is

displayed.
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Figure 43. Search County/City pop-up

4. Complete the Search County/City fields as indicated ugelerh County/City
Pop-up Field Instructions

5. After completing the Search County/City pop-up fields, clikd] . The County, City,
Zip, Congressional District list box on the List State/County/City/Zip/Congressional
District window igure 42 ) displays the geographical data based on the search criteria
entered. Click 4 | or ¢ | until the desired geographical data is displayed.

6. To perform another action, select the appropriate icon. To exit the system, all win
must be closed. At the FAAD menu, seleit > Exit .

Processing Suspense Records
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Several FAAD users transmit their data electronically or via tape to NFC for processing
this time, NFC personnel are responsible for accepting or rejecting the transmissions
depending on the number of errors in the transmission batch. However, client agencies
request access to correct their own suspense records. After a transmission is accepted
valid records are updated into the FAAD agreement tables during a nightly batch proce
routine. Records with errors are corrected via the online FAAD. The suspense header
information remains in the system until the end of the quarter. When the quarter has ended,
the suspense information is purged from the system in preparation for updating the next
quarter’s transmissions into the system.

When a transmission batch is received in the system, the Status Reldesed NFC

personnel determines whether or notd¢oegptor rejectthe transmission based on the Invalid
Record count field. If the transmission is accepted, the system updates the Statu®field to
Accept(Pending Accept). If the transmission is rejected, the system updates the Status field
to P Reject(Pending Reject).

For instructions on processing suspense records, see:

Accepting/Rejecting A Batch Transmission

Displaying A Suspense Record

Del